AUTHORING IN OWLV2
The OWLv2 Instructor Authoring system supplies you with the tools you need to
easily create and modify your own questions. By using intuitive features such as a
“WYSIWYG” editor, properties to control question behavior, and familiar options
for formatting, you can build assignments to suit your unique requirements.

OWLv2 Question Editor
When your self authored questions are complete, you can publish them to the
OWLv2 content banks where they are available for placement in your Test
assignments.
When selecting assignment content for Tests on the Available Items page, your
questions appear in a separate section labeled Self Authored Questions. If your
questions are organized into folders, the same folder hierarchy is maintained on
the content list.
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You can access the Instructor Authoring page from the following locations in
OWLv2:
From the Assignments page, click the Self Authored Questions link at
the top of the assignments table. (If you don’t see this link, you may need
to click Show All Options.)
From the Home page, click the Author New Questions link in the Quick
Links window. (You may need to enable the display of this link by using
the options on the Display Preferences page.)
Note: A Home page is not available when OWLv2 is accessed through an
integrated Learning Management System.
Authoring Topics
You can find descriptions on key topics in the following sections:
“Getting Started” on page 214. An overview of primary authoring
features.
“Creating Folders and Managing Questions” on page 215. How to
manage your questions and create folders for organizing and storing your
questions.
“Uploading Images” on page 219. How to upload your own graphics to
use in your self authored questions.
“Question Editor Overview” on page 220. Instructions on using the
Question Editor features.
“Creating a New Question” on page 230. Step by step instructions on
creating a new question.
Note: The information in this user guide is intended as a general reference only.
Refer to the OWLv2 online Textual Help for detailed instructions.
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GETTING STARTED
The first steps for authoring your own questions include creating folders,
uploading any images you may need, and selecting the appropriate question
template to create.

My Questions and Images pane
In the column on the left of the Instructor Authoring page, two tabs appear:
My Questions tab
Supplies options for managing folders and subfolders. You can organize
and sort your questions by type, difficulty, discipline, or any other
category of your choosing. See “Creating Folders and Managing
Questions” on page 215 for more details.
My Images tab
Provides you with tools for uploading new images and searching for one
of your existing images. You can later use these graphics in any of your
questions. See “Uploading Images” on page 219 for more details.
Below these tabs are buttons supplying basic options. The buttons you see
depend on which tab is selected.
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Create
With the My Questions tab selected, click this button to open the dialog
box for creating a new folder or question.
Search
With either the My Questions or My Images tab selected, click this button
to open the search dialog box. Enter part of a name to find either an
uploaded image or a specific question.
Publish
With either the My Questions or My Images tab selected, you can click
this button to publish all questions to the OWLv2 content banks. This
action also updates questions in untaken assignments.
Note: Before clicking Publish, you must click Save in the bottom right of
the editor, then click Save again in the upper right. If you don’t save first,
publishing will not send all your changes into the available assignment
content.

Creating Folders and Managing Questions
Use the options on the My Questions tab to create, delete, rename, edit
questions and folders, or move questions between your folders and subfolders.
Note: Folders can contain subfolders or questions, but not both.
The question types available for you to create from scratch are as follows. See
Creating a New Question on page 230 for step by step instructions.
Multiple Choice
Allows students to select an answer from a list of possible responses.
Multiple Select
A variation of Multiple Choice allowing students to select their answer
from a dropdown list of potential options. This question type supports
more than one correct response.
True False
Allows students to select true/false or yes/no to a question’s statement.
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Fill in the Blank
Allows students to enter or select a short response. Answer field types
include numeric, text, chem (provides students with a chemistry editor),
and select (similar to Multiple Choice, select answer fields provide a
dropdown list of possible responses).
Sample Questions with Image and Chemical Formula
A Multiple Choice template with instructions for inserting images and
creating chemistry and math formulae. You can use this template to get a
head start with creating a question with these elements or you can simply
use it as a guide.
Sample Question with Table
A Multiple Choice template with instructions for creating and editing
tables. You can use this template to get a head start with creating a
question with these elements or you can simply use it as a guide.
Sample Table with Math Formula, Table, and Hint
A Multiple Choice template with instructions for inserting images and
creating chemical and math formula. You can use this template to get a
head start with creating a question with these elements or you can simply
use it as a guide.

Step

Action: To create a folder

1

Click the Self Authored Questions link on the Assignments page to open the Instructor
Authoring page. You may need to click Show All Options, if the link is not displayed.

2

Click the Create button appearing at the top of the My Questions tab to open the
Create a New Folder and/or Question window.
Note: To create a subfolder, click Create a New Folder and/or Question
(folder icon) adjacent to the parent folder and follow the same steps
below.

3

Select Folder Name and enter a name in the Folder Name text box.

4

Click OK and the new folder appears in the My Questions column.

5

Click the “X” in the upper right corner of the window to exit without saving.
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Step

Action: To rename questions and folders

Once you’ve created a folder or question, you can edit their names at any time.
1

On the My Questions tab, mouse over the folder or question you want to rename, and
click Edit Folder Name or Edit Question Name (pencil icons).

2

In the Rename window that appears, enter the new name.

3

Click OK.
Note: You can also create a user friendly question name to appear in
assignments and reports using the Display Name property on the Edit
properties tab.

Step

Action: To move questions between folders

Once your folders and questions are in place, you can reorganize the folder contents.
1

On the My Questions tab, select the question(s) you would like to move.

2

Mouse over the folder to reveal the folder options.

3

Click the Move Selected Questions To This Folder icon.

4

Click OK in the confirmation dialog box.

Step

Action: To delete questions and folders

Once all the associated questions and subfolders are removed, you can delete a folder.
1

On the My Questions tab, open the folder you wish to delete.

2

If there are any questions inside the main folder, click the Delete Question (trash can)
icon to remove them. You can also move the questions into a different folder.

3

If there are any subfolders, delete or move those questions and then click the adjacent
Delete Folder icon.

4

Click the Delete Folder icon again to remove the final folder.
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Step
5

Action: To delete questions and folders
Click OK in the confirmation dialog box.
Note: Deleting a question on the Instructor Authoring page does not
affect copies of questions already placed in an assignment. Deleted
questions, however, no longer appear in the available assignment
content list after your changes are published.

Step

Action: To edit an existing question

Republishing edited questions updates the versions previously published to the available
assignment content list and also updates questions in any assignments that are not yet taken.
1

On the My Questions tab, find the question you need to edit.

2

Click the question name and the authoring pane repopulates with the selected
question.

3

Perform your edits, clicking the Save button for each tab as you work.

4

Click the global Save button at the top of the page when your changes are complete.

5

When your question is finished, click Publish to post your changes to the available
assignment content list and any untaken assignments that contain that question.
Note: Before clicking Publish, you must click Save in the bottom right of
the editor, then click Save again in the upper right. If you don’t save first,
publishing will not send all your changes into the available assignment
content.
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Uploading Images
You can upload copies of image files from your local computer into the OWLv2
server. These files are then available for you to organize into folders and access
anytime for use in your self authored questions. Also see “Creating Folders and
Managing Questions” on page 215 for information on folder management.

Step

Action: To upload an image file

Note: Unlike files saved from Upload Files on the Assignments page, your authoring files are
not accessible for your students to download.
1

Click the Self Authored Questions link on your Assignments page to open your
Instructor Authoring page.
You may need to click Show All Options, if the link is not displayed.

2

Select the My Images tab, if necessary.

3

Click the Upload button to open the Upload an Image window.

4

(Optional) Use the dropdown menu to Select an Existing Folder to place your question
or select Folder Name to create a new folder.
The Current folder is listed to the right.

5

Click Choose File and browse for the appropriate file on your computer.
Note: The maximum file size is 100kb. Unsupported file formats cannot
be selected.

6

Select the file you wish to use and click Open. The name of your selected file is now
displayed next to the Choose File button and an image preview appears below.

7

Once you confirm the appropriate file is selected, click the Upload button.

8

Click Done to exit and the file name appears in the list of uploaded images.

9

Manage your files by using the following options:
See a preview of an image by clicking the file name.
Rename a file by clicking Edit Image Name (pencil icon).
Delete a file by clicking Delete Image (trash can icon).
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QUESTION EDITOR OVERVIEW
The Question Editor offers editing capabilities for a variety of basic questions.
When you initially open the question editor the Home tab along with Format and
Find appear for every type of question template. These tabs supply key features
to assist you with creating the content for your new questions. They allow you to
include specialized question content, apply text formatting and styles, and a the
ability to search for and replace text.
You access the Question Editor from the following locations in OWLv2:
From the Assignments page, click the Self Authored Questions link at
the top of the assignments table. (If you don’t see this link, you may need
to click Show All Options.)
From the Home page, click the Author New Questions link in the Quick
Links window. (You may need to enable the display of this link from Edit
Page.)
Note: If you access OWLv2 through an integrated Learning Management
System, a Home page is not available.

Using the Question Editor
To help you add content and specialized objects in your questions and feedback,
the Home tab’s Question Editor is available from most editing areas on the
Instructor Authoring page. This “What You See Is What You Get” (WYSIWYG)
toolbar makes it easy to insert tables, graphs, formulas, and images uploaded from
your local system. You can also define and insert input and popup text fields.
These specialized options are introduced below.
Note: Also refer to the OWLv2 online Help for detailed instructions.
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The Question Editor supplies several generic options you can use when authoring
any type of template. The upper section of the Question Editor contains the
following controls, however, your available options depend on which question
type you are creating or editing.

Question Editor Features
Preview button
Click Preview to refresh the editor and display the current question in a
student view.
Editor button
Click Editor to return to the previous editing screen after viewing a
Preview.
Save button
Click the global Save button to save all your work on the current question.
Note: It’s always a good idea to save your work periodically, so that a
mistake or computer glitch doesn’t cost you a significant amount of work
or time.
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Done button
Click the Done button at the top of the screen to exit the Question Editor
and return to your original page in OWLv2.
Breadcrumb links
Click a link in the breadcrumb “trail” to return to a previous editing area.
Undo/Redo buttons
Click Undo to remove any changes you made to the question since the last
time you saved. Click Redo to revert back to the previous state.
Save/Cancel buttons
When available, click Save at the bottom of individual editing tabs before
opening a different tab. Click Cancel to leave the tab without saving your
changes.
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Home tab

The Home tab supplies entry fields for the question prompt, hints, a
solution, and feedback, as well as a Question Editor palette of tools for
inserting tables, graphs, formulas, symbols, images, answer fields, setting
options, and creating answers. The options available to you depend on
the selected question template.
Format tab

The Format tab supplies you with a palette of basic text editing options.
You simply select the text to be formatted and click the appropriate icon
to apply the changes.

OWLv2 for Integrated Systems User Guide for Instructors

July 3, 2017 pg. 223

Authoring in OWLv2

Find tab

The Find tab provides tools you can use to search for specific text or
perform a search and replace. Click either the Search or Replace buttons
to open the pane with the appropriate options.
Depending on the question template, the Question Editor toolbar can contain the
following controls:

The Question Editor Toolbar

Styles Menu
Use this dropdown menu to assign one of the pre formatted styles to the
selected text or object.
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Style Highlight
Click this icon to highlight the selected text with a opaque green bar. Click
Undo to remove the highlighting.
Insert Math Formula
Click this icon to insert formulae using advanced mathematical or
chemistry notation. The equation can include variables and a full range of
symbols.
Insert Chemistry Formula
Click this icon to open a basic Chemistry Formula Editor in a pop up
window. You can use this editor to create chemical formula with the
appropriate formatting.
Insert Image
Click this icon to open the Insert Image pane where you can upload and
place images in your questions, hints, or rejoinders. You can upload
images into OWLv2 from either the Insert Image window or from the My
Images tab. Files that are not in a usable format cannot be selected for
upload.
Insert Table
Click this icon to insert and format complex tables of information. Tables
are a helpful way to present a sample data set for use in a question. You
can use the Insert Table pane to set preferences such as adding rows,
columns, cell formatting, setting alignment, and shading.
Insert Symbol
Click this icon to open the Insert Symbol pane where you can choose from
a wide variety of custom characters to use in your question. Place a
symbol in your question or feedback field by selecting it from the pane.
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Insert Answer Field
In Fill in the Blank questions, you can use this dropdown menu to insert
an Input Field into the body of your question. Simply place your cursor on
the appropriate area in the Question field and make a selection for either
a chem, text, number, or select answer type.
The Answers tab automatically opens once you’ve selected a field. From
this tab you can author the responses, create rejoinders, and set a grading
tolerance. Double clicking in an input field opens the Answers tab again.
Edit True False
Click this icon In True False questions to open both the Answers and Edit
tabs where you can author feedback and edit settings specific to True
False questions.
You can also double click on the answer field to open both the Answers
and Edit tabs.
Edit Choices
In Multiple Choice and Multiple Select questions, clicking this icon opens
the Choices tab where you can choose to shuffle answer choices, author
the correct responses, and create feedback for each choice in your
question.
Edit Properties
Click this icon to open the Edit properties pane where you can set several
preferences that affect the behavior of your question.
Insert Popup
Highlight a section of text and click this icon to create a popup message
that appears when the selected text is clicked. You can set the popup
window’s width, height, and style (hotspot or popup) properties, then
enter the text for your message.
Click Insert when you are done, then click Preview to see how your
message appears in an assignment.
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Note: Right clicking on the question window provides quick access to some of the
more commonly used options.
Question
The Home tab’s Question field is generally your starting point. You use
this field to enter or edit the statement/prompt for the body of your
question.
Type directly into the editing field to enter the basis of your question. You
can then use the OWLv2 Question Editor to easily include images,
equations, graphs, tables, input (FITB) boxes, and format text.
Feedback
The Home tab’s Feedback field is used to enter or edit any feedback
messages you may want to provide for the question as a whole. This
message is shown at the bottom of the page only after the question is
answered and submitted.
You can also use the OWLv2 Question Editor to include images,
equations, graphs, tables, or format the text in your message.
Note: If the Feedback is not defined, a simple rejoinder of either
“Correct,” “Incorrect,” or “Partially Correct” is displayed, depending on
the score. (In questions that provide it, partial credit must be enabled to
use “Partially Correct.”)
Solution
The Home tab’s Solution field is used to enter or edit a message with
details about the correct response. This information is saved as a
comment that is visible only from within the Question Editor.
You can also use the OWLv2 Question Editor to include images,
equations, graphs, tables, or format the text in your comment.
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Hints
In the Hints field, you can author a series of hints to appear in the
question. Hints are different from feedback or rejoinders in that they
appear in a sequence and are viewable before the question is answered.
Students need to click the Hints button to have them displayed.
You can create multiple hints by clicking the Add Hint link. The hints
appear in ascending numbered order and are labeled so the student can
determine if more hints are available (For Example: “Hint #1 of #3). Hints
can also contain images, graphs, tables, equations, and formulas. Use the
Question Editor to insert these additional objects.

Advanced Question Editor Tabs
You can select additional editing tabs by clicking icons on the Question Editor. The
Edit Properties, Settings, Edit, and Answers tabs supply features for specifying
settings, setting preferences, creating answers, entering formulae, among other
options.
Note: The properties available on these tabs are generally unique to a particular
question, you can click the inline help icon
to quickly bring up the help page
for additional details.
Edit Properties Tab
When editing or creating questions in the Question Editor, clicking the
Edit Properties icon opens a pane of options allowing you to set a wide
variety of preferences.
On this tab you will find the more common property settings and grading
features, most of which are universal to all questions. You can alter the
default values for these properties to affect the functioning and
appearance of the question you’re authoring.
Settings Tab
The Settings tab generally contains options unique to a specific question
template. These options affect how the question operates and how it is
presented.
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Answers Tab
From the Answers tab you can create correct and incorrect responses and
specific feedback for each answer status. The steps and available options
for creating answers depends on your question type. Refer to the OWLv2
online help for specific examples for each
Clicking within the boundary box for the answer in the Question field or
clicking the Show All Answers button (when available) opens the virtual
editor where you can create or edit the correct answer. The options you
see may include properties for the answer type, scoring, accuracy, and
directed feedback (sometimes called “rejoinders”).
For some types of questions, such as True False, you simply identify which
response to the question is correct. For Multiple Choice and Multiple
Select questions, you enter the right answer and several wrong answers.
Well written wrong answers reduce the odds for successful guessing and
let you provide specific feedback (rejoinders) in response to common
mistakes. If you wish, you can also create “partially correct” answers and
rejoinders.
For Fill in the Blank questions where students type in their answers, you
can set up multiple answer rules that evaluate a range of possible
responses.
Table Tab
The Table tab appears when you select an existing table in the editing
field. You can use the available options on the Table toolbar to edit table
properties and formatting.
Tooltips Tab
The Tooltips tab allows you to create a brief popup message for input
fields. You can choose from premade message options or create your own
custom message.
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Creating a New Question
Once your folders are created and organized, you can begin authoring your own
questions. The procedure below provides a generic overview to help you get
started; refer to the descriptions on specific questions in the online help for
additional details. Also see “Question Editor Overview” on page 220 for details on
features available in the Question Editor.

Step

Action: To create a new question

Note: Before getting started, be sure to read the tips and instructions provided in the editor’s
text fields.
1

Go to your Assignments page and click the Self Authored Questions link to open the
Instructor Authoring page.
Note: You can also use the Author New Questions on the Quick Links
section of your Home page. (You will not have a Home page if you access
OWLv2 through an integrated Learning Management System.)

2

Click the Create button to open the Create a New Folder and/or Question window.
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Step

Action: To create a new question

3

(Optional) Use the dropdown menu to Select Existing Folder to place your question or
select Folder Name to create a new folder.

4

Select Chemistry from the Discipline dropdown menu.
Note: It is possible to author questions using most templates available
from the Accounting discipline, however, Essay questions are not
compatible with the OWLv2 Gradebook.
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Step
5

Action: To create a new question
Expand the Question Template dropdown menu and select the appropriate Question
Template.
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Step
6

Action: To create a new question
Choose one of the following types of templates:
Multiple Choice. Students select an answer from a list of
possible responses.
Multiple Select. Students select their answer from a dropdown
list of potential options. This question type supports more than
one correct response.
True False. Students select true/false or yes/no to the
question’s statement.
Fill in the Blank. Students enter or select a short response.
Sample Questions with Image and Chemical Formula. A
Multiple Choice template with instructions for inserting images
and creating chemical and math formulae.
Sample Question with Table. A Multiple Choice template with
instructions for creating and editing tables.
Sample Table with Math Formula, Table, and Hint. A Multiple
Choice template with instructions for inserting images and
creating chemical and math formulae.
Note: Sample templates are used to get a head start creating a
question or as an instructional guide.

7

Enter the Question Name.
The Question Name is used to identify the question within the content database; it can
contain no more than 20 characters, including spaces.
Note: You can also edit a Display Name property to create a name that
appears in assignments, reports, gradebooks, etc.

8

Click OK and the Question Editor for the selected template opens.

9

From the Home tab, enter the question statement and use the editor to add any special
objects (images, tables, symbols, etc.) in the Question field.

10

(Optional) Enter information for Feedback or Hints in the appropriate text fields.
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Step

Action: To create a new question

11

Depending on your question type, you can double click the Question field to open the
Answers tab to create responses.

12

Click Save at the bottom of the editing tabs to save your changes before moving on to
another area of the editor.

13

(Optional) Open the tabs for Edit Resources, Settings, or Edit to modify the question’s
default properties. The available tabs depend on the question template you are using.

14

(Optional) Click Preview to see a working version of your question.

15

When your question is complete, click the global Save button at the top of the editor.

16

Click Publish to add/update your question into the list of content resources available to
your Test assignments.
Note: Before clicking Publish, you must click Save in the bottom right of
the editor, then click Save again in the upper right. If you don’t save first,
publishing will not send all your changes into the available assignment
content.

17

Click the Done button at the top of the screen to exit the Question Editor and return to
your original page in OWLv2.
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